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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using and 
configuring the EVB-LAN9252-3PORT. Items discussed in this chapter include: 

• Document Layout

• Conventions Used in this Guide

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to configure the EVB-LAN9252-3PORT, such as the 
GPIO and SPI, as well as various setup options, scanning, and programming. The 
manual layout is as follows:

• Chapter 1. “Overview” – Shows a brief description of the EVB-LAN9252-3PORT 
board quick setup.

• Chapter 2. “EVB-LAN9252-3PORT” – Provides instructions in configuring GPIO.

• Appendix A. “Setting Up Master in Windows®” – This appendix shows how to 
set up Master in Windows.

• Appendix B. “EEPROM Programming” – This appendix shows how to program 
EEPROM.

• Appendix C. “Scanning EtherCAT Slaves” – This appendix shows how to scan 
EtherCAT Slaves.

• Appendix D. “Generating SSC Files” – This appendix shows how to generate 
SSC files.

• Appendix E. “Compiling and Programming SoC Firmware” – This appendix 
shows how to compile and program SoC firmware.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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• Appendix F. “Programming PIC32 Firmware Using Pre-Built Binaries” – This 
appendix shows how to change Vendor ID and Object configuration.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and 
PIC-kit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support
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Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revisions Section/Figure/Entry Correction

50002440A (02-03-16) Initial release of this document.
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Chapter 1.  Overview

1.1 INTRODUCTION

This document describes how to use the EVB-LAN9252-3PORT Software Develop-
ment Kit (SDK) as a development tool for the Microchip EVB-LAN9252 EtherCAT® 
Slave Controller.

1.1.1 Abbreviations

IDE - Integrated Development Environment

ESC - EtherCAT Slave Controller

EVB - Evaluation Board

HAL - Hardware Abstraction Layer

HBI - Host Bus Interface

SPI - Serial Protocol Interface

SSC - Slave Stack Code

Note: All the figures in the document are captured from TwinCAT 3.1.
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Chapter 2.  EVB-LAN9252-3PORT

2.1 ETHERCAT MASTER AND SLAVE CONFIGURATION

The following steps describe how to configure EtherCAT Master and Slave:

1. Configure the EtherCAT Master with the TwinCAT® driver.

2. Download and extract the EVB-LAN9252-3PORT_PIC32_SDK_Vx.x.zip 
from the Microchip website (http://www.microchip.com/LAN9252-041715a).

3. In SDK, the \ESI Files directory contains the ESI files which can be loaded to 
EVB-LAN9252-3PORT EEPROM using TwinCAT, as seen in Figure 2-1.

FIGURE 2-1: ESI FILES DIRECTORY 

4. Copy Microchip EVB-LAN9252-3PORT.xml to the directory path C:\Twin-
CAT\3.1\Config\Io\EtherCAT for TwinCAT 3.1.

5. Configure the evaluation board as mentioned in “Chapter 3. Board Configuration” 
of EVB-LAN9252-3PORT EtherCAT® ESC PHY Connection Mode User’s Guide 
from the Microchip website (http://ww1.microchip.com/downloads/en/Device-
Doc/50002403B.pdf).

6. By default, corresponding ESI file of PIC32 firmware is flashed to the delivered 
EVB-LAN9252-3PORT. To change the firmware in PIC32 SoC, refer to Appen-
dix D. “Generating SSC Files” and Appendix E. “Compiling and Program-
ming SoC Firmware”.

7. Launch TwinCAT and scan EtherCAT slaves from TwinCAT. Refer to Appendix 
C. “Scanning EtherCAT Slaves” to scan the slaves.

8. Program EEPROM using Microchip EVB-LAN9252-3PORT.xml. Refer to 
Appendix B. “EEPROM Programming” for EEPROM programming instruc-
tions. If the EEPROM is programmed successfully, the device state will enter into 
‘OP’ as displayed in Figure 2-2.

Note: Refer to Appendix A. “Setting Up Master in Windows®” for Windows® 
configuration.

Note: x.xx denotes the version number of the SDK.

Note: Refer to Appendix D. “Generating SSC Files” to change the Vendor ID 
and slave information in ESI files.

Note: The pre-built binaries are available in the “Binaries” directory. This step can 
be skipped if pre-built binary is used for programming.
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FIGURE 2-2: OP MODE

2.2 DEMO

The following describes a demo of the EVB-LAN9252-3PORT:

1. Follow the steps as mentioned in Section 2.1 “EtherCAT Master and Slave 
Configuration”. Two demo objects can be seen on the left side panel of the 
TwinCAT as displayed in Figure 2-3.

FIGURE 2-3: GPIO INPUTS AND OUTPUTS

2. As part of this demo, two object variables GPIO_INPUTS and GPIO_OUTPUTS 
are mapped to PIC32 GPIOs as mentioned below.

GPIO_OUTPUTS - PIC32 RD2
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GPIO_INPUTS - PIC32 RD3

3. Interconnect RD2 and RD3 hardware pins for demo purpose, as in Figure 2-5.

FIGURE 2-4: RD2 AND RD3

4. To change GPIO_OUTPUTS, double-click the GPIO_OUTPUTS option under 
Outputs in the Solution Explorer, as displayed in Figure 2-3.

The TwinCAT project window displays.

5. Click the Online tab in TWINCAT project window and select the Write option to 
change GPIO outputs, as displayed in Figure 2-5.

FIGURE 2-5: GPIO OUTPUTS

6. To view GPIO_INPUTS, double-click GPIO_INPUTS under Inputs in the Solution 
Explorer, as displayed in Figure 2-3.

7. Click the Online tab in the TwinCAT explorer window as displayed in Figure 2-6.
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FIGURE 2-6: GPIO INPUTS
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Appendix A. Setting Up Master in Windows®

A.1 INTRODUCTION

This appendix shows how to set up Master in Windows.

Download and install TwinCAT on Windows from http://beckhoff.com.

A.1.1 TwinCAT Ethernet Driver - Installation

To install the TwinCAT Ethernet Driver, do the following:

1. If TwinCAT installed successfully, a TwinCAT icon will display in the bottom-right corner of the desk-
top. Click the TwinCAT icon.

A pop-up menu displays.

2. Select TwinCAT XAE (VS XXXX), as displayed in Figure A-1.

FIGURE A-1: SYSTEM MANAGER

3. Go to TWINCAT>Show Real Time Ethernet Compatible Devices… as in Figure A-2.

Note: VS XXXX refers to version of Visual Studio installed on the computer.
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FIGURE A-2: SHOW REAL TIME ETHERNET COMPATIBLE DEVICES

4. Select the Network adapter and install the TwinCAT driver as in Figure A-3.

FIGURE A-3: ETHERNET ADAPTERS DIALOG

5. Once the TwinCAT driver is installed successfully, the driver is compatible with the TwinCAT master. 
The network adapter will then be moved to “Installed and ready to use devices” as displayed in 
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Figure A-4.

FIGURE A-4: INSTALLED AND READY TO USE DEVICES

6. Go to the corresponding network adapter properties and then select TwinCAT drivers as displayed in 
Figure A-5 and Figure A-6.

FIGURE A-5: NETWORK ADAPTER PROPERTIES MENU
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FIGURE A-6: LOCAL AREA CONNECTION PROPERTIES

Note 1: Only select TwinCAT drivers.

2: If TwinCAT cannot find the EtherCAT slaves after following the steps in Appendix 
C. “Scanning EtherCAT Slaves”, restart the computer and attempt to scan again.
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Appendix B. EEPROM Programming

B.1 INTRODUCTION

This appendix shows how to program EEPROM.

B.1.1 EEPROM Programming

To program EEPROM:

1. After a successful scan, click the “Device 2 (EtherCAT)” drop-down bar from the Solution Explorer of 
the TwinCAT tool, as displayed in Figure B-1.

The TwinCAT Explorer window displays.

FIGURE B-1: DEVICE 2 (ETHERCAT)

2. Click the Online tab in the TwinCAT project window.

3. Right-click the LAN9252 listing and select “EEPROM Update” from the contextual menu, as displayed 
in Figure B-2.

The Write EEPROM window displays.
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FIGURE B-2: EEPROM UPDATE

4. Select the corresponding EEPROM configuration and then click OK to initiate EEPROM program-
ming.

For example, Figure B-3 shows LAN9252 one of DIGIO configuration is selected for EEPROM pro-
gramming in the TwinCAT.
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FIGURE B-3: WRITE EEPROM DIALOG
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Appendix C. Scanning EtherCAT Slaves

C.1 INTRODUCTION

This appendix shows how to scan EtherCAT Slaves.

C.1.1 Scanning EtherCAT Slaves

To scan EtherCAT slaves:

1. Connect Port 0 of the device to master using RJ45 Ethernet cable, and then power up the board.

The Link/Act LED should be ON at Port 0 when the cable is present. If the Link/Act LED is not ON, it 
indicates there is an issue with the connection or cable.

2. If any devices are present, delete them accordingly by right-clicking the device and selecting Remove, 
as displayed in Figure C-1.

FIGURE C-1: REMOVE DEVICE

3. Scan for EtherCAT slave devices by right-clicking Devices under I/O and then selecting Scan, as dis-
played in Figure C-2.



EVB-LAN9252-3PORT Quick Start Guide

DS50002440A-page 28  2016 Microchip Technology Inc.

FIGURE C-2: SCAN DEVICES MENU

4. Click OK to continue scanning, as in Figure C-3.

FIGURE C-3: DEVICE DIALOG

If the check box is not checked, as displayed in Figure C-4, then either the device is not functional or 
driver is not installed properly.
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FIGURE C-4: DEVICE DIALOG, UNCHECKED

5. Click Yes as displayed in Figure C-5 to scan for boxes.

FIGURE C-5: CONFIRMATION DIALOG

The device list displays, as in Figure C-6.
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FIGURE C-6: DEVICE LIST

6. After a successful scan, there will be an activity on Link/Act LED at Port 0.
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Appendix D. Generating SSC Files

D.1 INTRODUCTION

This appendix shows how to generate SSC files.

D.1.1 Generating SSC Files

To generate SSC files:

1. Start the SSC Tool from the Windows Start menu, as displayed in Figure D-1.

FIGURE D-1: SSC TOOL

2. From the menu bar, click File>New, as displayed in Figure D-2.

FIGURE D-2: NEW ETHERCAT SLAVE

3. Click Import to import the SSC Tool configuration file Microchip 
EVB-LAN9252-3PORT-SSC-CONFIG.xml from the directory {SDK_INSTALL_PATH}/ 
EVB-LAN9252_SDK_VX.X\EVB-LAN9252-3PORT_PIC32_SDK_VX.X/ as displayed in 
Figure D-3.
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FIGURE D-3: IMPORT PROJECT

4. After selecting the file, click Open to import the SSC Tool configuration file.

5. Once imported, check the “Custom” drop-down box, select “Microchip-EVB-LAN9252-3PORT” con-
figuration, as displayed in Figure D-4.

6. Click OK.

FIGURE D-4: CUSTOM SSC FILE SELECTED

7. All listed parameters under the Slave Information tab can be changed as displayed in Figure D-5.

Note: By default, SDK ESI files have an object configuration with Microchip Vendor ID.
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FIGURE D-5: SLAVE SETTINGS

8. Click Tool>Application>Import from the menu bar, as displayed in Figure D-6.

FIGURE D-6: IMPORT MENU

9. Select the file pic32_mchp_gpio_sample_app.xlsx which can be found in the directory 
{SDK_INSTALL_PATH}/EVB-LAN9252_SDK_VX.X\EVB-LAN9252-3PORT_PIC32_SDK_VX.X/.

pic32_mchp_gpio_sample_app.xlsx is an object file which contains the information about appli-
cation objects information.

Once the file is selected, status message displays, as in Figure D-7.
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FIGURE D-7: STATUS MESSAGE

10. Click OK to continue.

11. Click the “Project” drop-down menu in the tool bar and select Create New Slave Files.

The Create new Slave Files window displays, as in Figure D-8.
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FIGURE D-8: CREATE NEW SLAVE FILES

12. Click Start to create a new project file, Src folder, and ESI file (Slave Information file) in the desired 
directory path.

A pop-up window displays to indicate that the files have been successfully created.

13. Click OK to continue.

Along with generated new slave files, ESI file (.xml file) also will be generated. This ESI file will have 
information about new Vendor ID and object configuration.

14. Program this ESI file into EEPROM, as mentioned in Appendix B. “EEPROM Programming”.

15. Replace generated application files with SDK application files as displayed in Figure D-9. 

SDK Application files can be found under ./Common directory.

Note: The above values signify the following:

- $PROJECT_FILE_PATH - The location where the SSC project file is saved.

- $SRC_FILE_PATH - Default path is $PROJECT_FILE_PATH. It can be changed by clicking its 
corresponding Change button.

- $ESI_FILE_PATH - Default path is $PROJECT_FILE_PATH. It can be changed by clicking its 
corresponding Change button.
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FIGURE D-9: SDK APPLICATION FILES

FIGURE D-10: APPLICATION FILES

16. Browse to the directory where the new files were created, as shown in the example: 

- Src (Folder): This folder contains the Beckhoff Slave Stack code. 

- Microchip PIC32 Slaves (ESP): This is the SSC Tool project file. 

- Microchip PIC32 Slaves (XML): This is the EtherCAT slave information file that must be 
used as an input to the EtherCAT master tool to configure EtherCAT slave controllers.

17. Copy all the files inside the Src folder to the following directory:

{SDK_INSTALL_PATH}/EVB-LAN9252-3PORT_PIC32_SDK_VX.X/SSC/Common

D.1.1.1 WHY REPLACE IS REQUIRED

Generated application files will not have the code for accessing the GPIO lines. GPIO support is provided 
in delivered SDK application files. Hence, the replace is required to get the demo application.

Note: Application files would be named as pic32_mchp_gpio_sample_app as in Figure D-10. This 
is because in this demo, input object file is given as pic32_mchp_gpio_sample_app.xlsx 
as provided in step 2.
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Appendix E. Compiling and Programming SoC Firmware

E.1 INTRODUCTION

This appendix shows how to compile and program SoC firmware.

E.1.1 Compiling and Programming SoC Firmware

To compile and program SoC firmware:

1. Open the MPLAB® IDE and import the SSC project.

The MPLAB project file is located under {SDK_INSTALL_-
PATH}/EVB-LAN9252-3PORT_PIC32_SDK_VX.X/SSC/.

2. Compile the source code as displayed in Figure E-1.

FIGURE E-1: SOURCE CODE

If the compilation is successful, the output window will display “BUILD SUCCESSFUL” as in 
Figure E-2.

FIGURE E-2: BUILD SUCCESSFUL

3. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB’s 
JTAG pins.

4. To program the PIC32 SoC, click the Make and Program Device Main Project button, as displayed 
in Figure E-3.

Note: This demo project is debugged with the PICkit 3 In-Circuit debugger/programmer.
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FIGURE E-3: MAKE AND PROGRAM DEVICE MAIN PROJECT BUTTON

5. To debug the PIC32 SoC, click the Debug Main Project button, as displayed in Figure E-4.

FIGURE E-4: DEBUG MAIN PROJECT
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Appendix F. Programming PIC32 Firmware Using Pre-Built 
Binaries

F.1 INTRODUCTION

This appendix shows how to program PIC32 firmware.

F.1.1 Programming PIC32 Firmware Using Pre-Built Binaries

Follow these steps to program the PIC32 firmware using pre-built binaries:

1. Download and install MPLAB IPE Vx.xx from the following link:

http://microchip.wikidot.com/ipe:installation

2. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB’s 
JTAG pins.

3. Open the MPLAB IPE.

The window displays as in Figure F-1.

Note: x.xx denotes the version number of the MPLAB IPE.
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FIGURE F-1: MPLAB IPE

4. Select the corresponding device from the “Device” drop-down box and then click Apply.

5. Select the debugger/programmer from the “Tool” drop-down box and then click Connect.

6. From “Source,” click Browse and select the hex files which can be found in the Binaries directory 
of EVB-LAN9252-3PORT_PIC32_SDK_VX.X.

7. Once the hex files are loaded, click Program.



DS50002440A-page 41  2016 Microchip Technology Inc.

AMERICAS
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200 
Fax: 480-792-7277
Technical Support: 
http://www.microchip.com/
support
Web Address: 
www.microchip.com

Atlanta
Duluth, GA 
Tel: 678-957-9614 
Fax: 678-957-1455

Austin, TX
Tel: 512-257-3370 

Boston
Westborough, MA 
Tel: 774-760-0087 
Fax: 774-760-0088

Chicago
Itasca, IL 
Tel: 630-285-0071 
Fax: 630-285-0075

Cleveland
Independence, OH 
Tel: 216-447-0464 
Fax: 216-447-0643

Dallas
Addison, TX 
Tel: 972-818-7423 
Fax: 972-818-2924

Detroit
Novi, MI 
Tel: 248-848-4000

Houston, TX 
Tel: 281-894-5983

Indianapolis
Noblesville, IN 
Tel: 317-773-8323
Fax: 317-773-5453

Los Angeles
Mission Viejo, CA 
Tel: 949-462-9523 
Fax: 949-462-9608

New York, NY 
Tel: 631-435-6000

San Jose, CA 
Tel: 408-735-9110

Canada - Toronto
Tel: 905-673-0699 
Fax: 905-673-6509

ASIA/PACIFIC
Asia Pacific Office
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon

Hong Kong
Tel: 852-2943-5100
Fax: 852-2401-3431

Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755

China - Beijing
Tel: 86-10-8569-7000 
Fax: 86-10-8528-2104

China - Chengdu
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

China - Chongqing
Tel: 86-23-8980-9588
Fax: 86-23-8980-9500

China - Dongguan
Tel: 86-769-8702-9880 

China - Hangzhou
Tel: 86-571-8792-8115 
Fax: 86-571-8792-8116

China - Hong Kong SAR
Tel: 852-2943-5100 
Fax: 852-2401-3431

China - Nanjing
Tel: 86-25-8473-2460
Fax: 86-25-8473-2470

China - Qingdao
Tel: 86-532-8502-7355
Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533 
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

China - Shenzhen
Tel: 86-755-8864-2200 
Fax: 86-755-8203-1760

China - Wuhan
Tel: 86-27-5980-5300
Fax: 86-27-5980-5118

China - Xian
Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

ASIA/PACIFIC
China - Xiamen
Tel: 86-592-2388138 
Fax: 86-592-2388130

China - Zhuhai
Tel: 86-756-3210040 
Fax: 86-756-3210049

India - Bangalore
Tel: 91-80-3090-4444 
Fax: 91-80-3090-4123

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-3019-1500

Japan - Osaka
Tel: 81-6-6152-7160 
Fax: 81-6-6152-9310

Japan - Tokyo
Tel: 81-3-6880- 3770 
Fax: 81-3-6880-3771

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul
Tel: 82-2-554-7200
Fax: 82-2-558-5932 or 
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068

Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069

Singapore
Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-5778-366
Fax: 886-3-5770-955

Taiwan - Kaohsiung
Tel: 886-7-213-7828

Taiwan - Taipei
Tel: 886-2-2508-8600 
Fax: 886-2-2508-0102

Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE
Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393

Denmark - Copenhagen
Tel: 45-4450-2828 
Fax: 45-4485-2829

France - Paris
Tel: 33-1-69-53-63-20 
Fax: 33-1-69-30-90-79

Germany - Dusseldorf
Tel: 49-2129-3766400

Germany - Karlsruhe
Tel: 49-721-625370

Germany - Munich
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44

Italy - Milan 
Tel: 39-0331-742611 
Fax: 39-0331-466781

Italy - Venice
Tel: 39-049-7625286 

Netherlands - Drunen
Tel: 31-416-690399 
Fax: 31-416-690340

Poland - Warsaw
Tel: 48-22-3325737 

Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91

Sweden - Stockholm
Tel: 46-8-5090-4654

UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820

Worldwide Sales and Service

07/14/15



X-ON Electronics
 
Largest Supplier of Electrical and Electronic Components
 
Click to view similar products for Ethernet Development Tools category:
 
Click to view products by  Microchip manufacturer:  
 
Other Similar products are found below :  

KSZ8863FLL-EVAL  KSZ8873MLL-EVAL  PD-IM-7648M  PD-IM-7648T4  PD70101EVB15F-12  PD70101EVB6F  PD70211EVB50FW-5 

PD70211EVB72FW-12  EV44F42A  WIZ550S2E-232-EVB  DFR0272  A000024  DFR0125  UKIT-006GP  UKIT-003FE  UKIT-002GB  UKIT-

001FE  EVB-KSZ9477  OM-E-ETH  DP83867ERGZ-R-EVM  UP-POE-A20-0001  2971  3785  ASX00006  ASX00021  ASX00026  XTIB-E 

ESP32-ETHERNET-KIT-VE  EVB-KSZ9897-1  KSZ9031MNX-EVAL  AC164121  AC164132  AC320004-5  AC320004-6  AC320004-7 

DM320114  DM990004  EV02N47A  EV44C93A  EV57N07A  EVB-KSZ8563  EVB-KSZ9477-1  EVB-KSZ9893  EVB-LAN7430  EVB-

LAN7431-EDS  EVB-LAN7800LC-1  EVB-LAN7850  EVB-LAN9252-3PORT  EVB-LAN9252-ADD-ON  EVB-LAN9252-DIGIO  

https://www.x-on.com.au/category/embedded-solutions/engineering-tools/communication-development-tools/ethernet-development-tools
https://www.x-on.com.au/manufacturer/microchip
https://www.x-on.com.au/mpn/micrel/ksz8863flleval
https://www.x-on.com.au/mpn/micrel/ksz8873mlleval
https://www.x-on.com.au/mpn/microchip/pdim7648m
https://www.x-on.com.au/mpn/microchip/pdim7648t4
https://www.x-on.com.au/mpn/microchip/pd70101evb15f12
https://www.x-on.com.au/mpn/microchip/pd70101evb6f
https://www.x-on.com.au/mpn/microchip/pd70211evb50fw5
https://www.x-on.com.au/mpn/microchip/pd70211evb72fw12
https://www.x-on.com.au/mpn/microchip/ev44f42a
https://www.x-on.com.au/mpn/wiznet/wiz550s2e232evb
https://www.x-on.com.au/mpn/dfrobot/dfr0272
https://www.x-on.com.au/mpn/arduino/a000024
https://www.x-on.com.au/mpn/dfrobot/dfr0125
https://www.x-on.com.au/mpn/pulse/ukit006gp
https://www.x-on.com.au/mpn/pulse/ukit003fe
https://www.x-on.com.au/mpn/pulse/ukit002gb
https://www.x-on.com.au/mpn/pulse/ukit001fe
https://www.x-on.com.au/mpn/pulse/ukit001fe
https://www.x-on.com.au/mpn/microchip/evbksz9477
https://www.x-on.com.au/mpn/onion/omeeth
https://www.x-on.com.au/mpn/texasinstruments/dp83867ergzrevm
https://www.x-on.com.au/mpn/aaeon/uppoea200001
https://www.x-on.com.au/mpn/adafruit/2971
https://www.x-on.com.au/mpn/adafruit/3785
https://www.x-on.com.au/mpn/arduino/asx00006
https://www.x-on.com.au/mpn/arduino/asx00021
https://www.x-on.com.au/mpn/arduino/asx00026
https://www.x-on.com.au/mpn/digiinternational/xtibe
https://www.x-on.com.au/mpn/espressif/esp32ethernetkitve
https://www.x-on.com.au/mpn/microchip/evbksz98971
https://www.x-on.com.au/mpn/micrel/ksz9031mnxeval
https://www.x-on.com.au/mpn/microchip/ac164121
https://www.x-on.com.au/mpn/microchip/ac164132
https://www.x-on.com.au/mpn/microchip/ac3200045
https://www.x-on.com.au/mpn/microchip/ac3200046
https://www.x-on.com.au/mpn/microchip/ac3200047
https://www.x-on.com.au/mpn/microchip/dm320114
https://www.x-on.com.au/mpn/microchip/dm990004
https://www.x-on.com.au/mpn/microchip/ev02n47a
https://www.x-on.com.au/mpn/microchip/ev44c93a
https://www.x-on.com.au/mpn/microchip/ev57n07a
https://www.x-on.com.au/mpn/microchip/evbksz8563
https://www.x-on.com.au/mpn/microchip/evbksz94771
https://www.x-on.com.au/mpn/microchip/evbksz9893
https://www.x-on.com.au/mpn/microchip/evblan7430
https://www.x-on.com.au/mpn/microchip/evblan7431eds
https://www.x-on.com.au/mpn/microchip/evblan7431eds
https://www.x-on.com.au/mpn/microchip/evblan7800lc1
https://www.x-on.com.au/mpn/microchip/evblan7850
https://www.x-on.com.au/mpn/microchip/evblan92523port
https://www.x-on.com.au/mpn/microchip/evblan9252addon
https://www.x-on.com.au/mpn/microchip/evblan9252digio

